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[% Notices

- No part of the manuals associated with this product may be reproduced, transmitted, tran-
scribed, stored in a retrieval system, or translated into any language in any form, by any means,
without Nikon’s prior written permission.

- Nikon reserves the right to change the specifications of the hardware and software described in
these manuals at any time and without prior notice.

« Nikon will not be held liable for any damages resulting from the use of this product.

- While every effort has been made to ensure that the information in this manual is accurate and
complete, we would appreciate it were you to bring any errors or omissions to the attention of
the Nikon representative in your area (address provided separately).
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Introduction

What Capture NX-D Can Do for You

I B .}

Capture NX-D lets you fine-tune pictures by, for example, adjusting brightness
and hue, and can also be used to edit RAW images taken with Nikon digital cam-
eras and save them in other formats.

Fine-Tune Pictures

With Capture NX-D, it’s easy to adjust such settings as brightness and white balance
(page 18). Certain settings, such as exposure compensation and Picture Controls,
are available only with RAW images.

w Original

+  Original
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+ (Original

v Original

Capture NX-D Reference Manual

Copy Adjustments

Save adjustmentsand apply themtootherimages(page 32) or copy themto other
computers (page 34). Saved adjustments can be applied to multiple images using
batch processing (page 38).

Save Pictures in Other Formats

Fine-tuned or processed RAW (NEF/NRW) images can be saved in JPEG or TIFF
formats for use in other applications (page 35).
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What Capture NX-D Can Do for You

Fine-Tuning Pictures in Capture NX-D Because changes to settings are stored separately from the original image data,
the original picture can be restored at any time with no drop in quality.

Capture NX-D stores image adjustments in a separate “sidecar” file that is up-
dated automatically as settings are changed.

> |

Settings file
Settings file deleted or
settings reset
Fine-tuning preview
When files are converted to JPEG or TIFF, the changes are applied to the image as
- it is saved to create a new, modified image data file.
Exposure compensation
y - i Settings

4 Image Adjustments = NI =1 1 ~ . "
Image adjustments are stored in a “NKSC_PARAM"folder in the same folder as the original image. All Original image JPEG or TIFF file
changes will be lost if this folder or the image adjustment file is deleted; similarly, because the image

and the image adjustment file are linked via the file name, changes will be lost or applied to another
image if the image adjustment file is renamed.

When opening images modified in ViewNX-i, Capture NX-D also reads the associated settings files
and preserves the adjustments they contain.

Capture NX-D Reference Manual 3
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Hiding Changes Made in Capture NX/Capture NX 2

Capture NX-D can be used in combination with
Capture NX and Capture NX 2. To hide changes
made using Capture NX or Capture NX 2, click
the B button in the edit palette (page 7) to
display the Version tool and deselect Apply
adjustment steps. This applies only to modifi-
cations made using the tools in the “Enhance-
ment Steps” (Capture NX) or “Adjust” section
(Capture NX 2); images modified using these
tools are indicated by & icons in the thumb- Save Al Adustments..
nail list. Load Adjustments..

m Unsupported Images

Images that have been modified using the
Color Efex Pro plugin for Capture NX or
Capture NX 2 can be fine-tuned in Capture
NX-D by first resetting all changes using the re-
vert buttonin the edit palette (page 7). Pictures
that have been modified using Color Efex Pro
are indicated by Bl icons in the thumbnail list.

Revert button

Register Updated Adjustments. ..

Register All Adjustments. .

Version
m Apply History Setting
The image below has been modified using the Picture Control tool in the
“Develop” section and the Gaussian Blur tool in the “Adjust” section of
Capture NX 2. Deselecting Apply adjustment steps in Capture NX-D hides only
the effects of the “Gaussian Blur” tool.

RAW (NEF/NRW) Images

Changes made to RAW (NEF/NRW) images in Capture NX-D, including those made using the revert but-
ton, are not reflected in Capture NX or Capture NX 2. RAW (NEF/NRW) images opened in Capture NX or
Capture NX 2 will be restored to the state they were in when they were last saved in these applications,
regardless of any changes made in the interim using Capture NX-D.

NEF Conversion
JPEG or TIFF images converted to NEF in Capture NX or Capture NX 2 are treated as JPEG or TIFF
images in Capture NX-D and can not be modified using options such as exposure compensation
(page 20) and white balance (page 21) that apply only to RAW (NEF/NRW) images.

Apply adjustment steps: @ Apply adjustment steps: E

Capture NX-D Reference Manual 4
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The Capture NX-D Window

- I __ __ 0 Capture NX-D__ DSC_0001.NEF - S BEM (7) Menu bar: Access the menus (page 9).

- e @‘ (2 Toolbar: Choose a view and access image ad-
justment tools (page 8).

(3) Folder palette: Select a folder to display its con-
tents in the image area (page 6).

(4) Image area: View the images in the current

folder.

@* (5) Selected image: Selected images are high-

lighted in gray, with images that have been
modified indicated by a [E icon at the top left
corner of the thumbnail. Double-click to pre-

view (page 10).

S| (6 Histogram palette: View the tone distribution
for the selected image (page 6).

(7) Edit/metadata palettes: Fine-tune images using
the tools in the edit palette or switch to the
metadata palette to view image information
(page 7).

¢ (8) Status bar: View information on the selected

.I E image (page 9).

The Navigation Palette

A navigation (bird’s eye) palette (page 6) appears when a preview is displayed by double-clicking a thumbnail in the image area.

Capture NX-D Reference Manual 5
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Palettes
Capture NX-D offers the following palettes. The Histogram Palette
The histogram palette provides a constantly- Channel menu
The Folder Palette updated histogram for the selected thumbnail - [m——
The folder palette lists the folders in the com- or the image in the preview display. The histo-
puter’s storage system. Click a folder to view C \user\Pictures\Nikon gram shows the tone distribution for the color

channel selected in the channel menu. Choose
RGB to view overlapping distributions for the
red, green, and blue channels: tone ranges in
which the distributions for red and green over-
lap are shown in yellow, those in which red and
blue overlap in magenta, those in which green
and blue overlap in cyan, and those in which all
three colors overlap in white.

the images it contains in the image area or pre-
view display.

F The Navigation (Bird’s Eye) Palette

Libraries The navigation palette is displayed above the
Ietwork folder palette when you double-click a thumb-
nail to display a preview.

The folder palette menu gives access to recent
folders. Frequently-used folders can be added C\Usersluser\PicturesiNikon
to and then accessed from this menu. Register to Menu...

Organize Menu...

When the preview is zoomed in, the frame

W C:\sersiuseriPicturesiNikon . . .
CUsersiuseriPictures in the navigation palette shows the area cur-

ClUsersiuser rently displayed. Drag the frame to view other
Clear History .
areas of the preview.

1
Folder palette menu

Palette Menus
To access the palette menu, click the triangle (&) at the top right corner of the palette. Select Undock
to open the palette in a floating window that can be moved freely about the display.

Capture NX-D Reference Manual 6



Rl s e e oo e
Palettes
The Edit Palette The Metadata Palette

Use the tools in the edit palette to adjust
the image currently selected or previewed
in the image area. The tool list (page 18) offers
Exposure Compensation, White Balance,
Picture Control, and Tone/Tone (Detail) tools
that can be accessed via pull-down menus or
by clicking the tool icon and adjusting settings
in the adjustments palette (page 18). Additional
tools can be accessed using the tool buttons
(page 19) at the bottom of the palette. The
adjustmentmanager tool (page 19) can be used
to copy adjustments to other images or save
current settings for later use. To reset all tools
and restore the image to the state it was in
when first opened in Capture NX-D, click the
revert button (note that any changes made to
JPEG and TIFF images in other applications
since they were last opened in Capture NX-D
will not be reset).

The Edit and Metadata Palettes

Edit tab Tool list

‘ Adjustment manager

w  Original

» Original

4:} Adjustments

v Original

Copy AllAd

Paszte Adjustments

\ll Adjustments. ..

Adjustments palette

-Tool buttons Revert button

Use the tabs at the top left corner to switch between the edit and metadata palettes.

Capture NX-D Reference Manual

The metadata palette lists information on the
image currently selected or previewed in the
image area, including exposure, the model of
camera used to record the picture, and the
date and time of recording. The metadata pal-
ette can be displayed in the position normally
occupied by the folder palette (page 6) by se-
lecting Dock to Left in the palette menu.

Metadata tab

File Info 1

File DSC_0001.NEF
Date Created 7/15/2015 8:59:57 AM
Date Modified 11/8/2013 2:14:10 AM

File Size 17.0MB

Image Size L (4928 x 3280), FX
File Info 2

Date Shot 114812013 18:14:09 .45

Time Zone amUTC+9, DST.OFF
Image Quality Lossless Compressed RA

Camera Info
Device Mikon D43
Lens 24-35mm f13.5-4.5G

Focal Length 62mm

Focus Mode AF-S

AF-Area Mode Single

VR

AF Fine Tune OFF
Exposure

Aperture fl4.5
Shutter Speed 1/4s
Exposure Mod Manual
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The Toolbar

I R .}

Use the toolbar to choose a view and access image adjustment tools.

Capture NX-D__DSC.0001.NEF

*

Tk
E et &
@S EFC | XY ¥V ERE (VN®

(=]}

®@OEE®® @i 1312151647 18019 ey

©) Back/Foward Select the folder before or after the current folder.
@ Wr=g Folder Display a dialog where you can navigate to and open a folder.

Choose a view mode for the image area.

View images side-by-side. Choose from Compare Before and
After Images and 2 Images.

Apply current adjustments to the "before”image for use as a refer-
ence when making further modifications.

®) JB& § Current

® Original

@ E NEF/NRW + JPEG

Restore the “before”image to the state it was in before any adjust-
ments were made.

If the folder contains images shot atimage quality settings of "RAW
+ JPEG’, select this option to list the RAW and JPEG copies sepa-
rately.

Capture NX-D Reference Manual

Page 6
Page 10

Page 13

Page 13

Page 13

Page 10

@ \i:-:
) Batch Process Status

12 |E3a] Cancel Batch Process

19 o
Ul =
2 |is

Access the fit, image viewer, zoom, and hand tools. —

Click a point in the preview to adjust white balance so that the
sampled point takes on a neutral gray color (gray point sample Page 21
tool).

Straighten images. Page 29

Crop images. Page 36

Rotate images 90°. The direction of rotation can be selected by
keeping the button pressed.

Filter images by rating or label. Page 17

Filter images by rating, label, or camera settings. Page 17

End filtering and view all images. —

View batch process status. Page 38

Cancel batch processing. —

View the currentimage or images in ViewNX-i. The images are dis-
played in their current state including any changes made using
Capture NX-D and, in the case of NEF/NRW (RAW) images, without
conversion to TIFF.

Convert images to 16-bit TIFF and open them in an application

previously selected using the Open With Application option. Page 43

Print the image currently selected or previewed in the image area. Page 40

Save images in JPEG or TIFF format. Adjustments are applied be-

fore the image is saved. Page 35
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The Status Bar The Menu Bar

View information on the image selected or previewed in the image area. Access image adjustment tools or save images in other formats.

B Capture NX-D__ DSC_000T.NEF

Capture NX-D__ DSC.0001.NEF

File(E) Edit(E) Wi M Image(l) Adjust(4) Tool(T)

File name The file name. (D File Convert files to other formats, run batch processes, and print and rename files.
Zoom ratio The zoom ratio at which the preview is currently displayed. @ Edit Select, copy, paste, and delete images.
= Color space The color space of the image in the preview display. (3 View  Choose a view mode, adjust zoom, and sort and select images.
Image size The size (in pixels) of the image in the preview display. (@) Image Rotate, rate, and label images or display a grid or the focus point, shadows, or highlights.
Color value The color of the pixel under the cursor in the preview and image (® Adjust Copy, paste, save, and load image adjustment settings.
viewer displays. (B Tool  Accessimage adjustment tools.

® m Position in folder The position of the currentimage and the total number of images (@) Window View and hide palettes.
in the folder. Click |l or Iz to view other images. ' ' : . ' : :
Help View online help. In Windows, this option also displays the current software version number.

Capture NX-D Reference Manual 9
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Viewing Pictures

Viewing Pictures

I )

Capture NX-D offers the following viewing options.

Thumbnails

At default settings, Capture NX-D lists the images in the current folder as thumb-
nails. Selected images are highlighted in gray.

Capture NX-D  DSC_0001.NEF
File(F) Edi(E

Thumbnail Size

Use the slider above the image area to choose the thumbnail size.

Capture NX-D Reference Manual

Previews

To display a preview, double-click a thumbnail, or select a thumbnail and then
click the view mode button in the toolbar and select Preview.

v 52 Thumbnail

Bt Fimaan

O Preview

W FUll DCreen

Capture NX-D  DSC_0001.NEF ( 20.3%)
File(F) EdI(E)

Returning to the Thumbnail View
To return to the thumbnail view, click the view mode button in the toolbar and
select Thumbnail.

£22 Thumbnail

=== IMage viewer
v [ Preview

LV
' Full Screen

Same Name, Different Extension

If the folder contains pairs of images with the same file names but different extensions (for example,
RAW and JPEG images recorded at image quality settings of “RAW + JPEG"), only one copy of each pair
will be displayed when NEF/NRW + JPEG is on. To view all images, turn NEF/NRW + JPEG off.

EPSHAC I x YV EIE (VO ab

10
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Viewing Pictures

Other Features

Image Adjustment

Viewing Pictures

The Image Viewer

To preview the current image with thumbnails above, below, or to one side, click
the view mode button in the toolbar and select Image Viewer.

FTACWERE

4 55 Thiimabnail

SHCG Y ¥ EES

™ Image Viewer

— T IEVIG

= Full Screen

(Capture NX-D  DSC_0001.NEF ( 14.5% )
File(F) EJH(E) V

e Y N

2 P e
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Choosing the Location of the Preview and Thumbnail Palettes
The locations of the preview and thumbnail palettes can be selected from the palette menus.

Undock

Dock to Bottom
Dockto Left
Dock to Right
Close

Preview palette menu

Capture NX-D  DSC_0001.NEF ( 14.5%)
File(F) E(E) Vie

Undock
Dock to Top
Dock to Left
Dock to Right
Close

Thumbnail palette menu

11
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Viewing Pictures

Viewing Images Full Screen Use the left and right arrow keys on the keyboard to view additional images.

To hide the menus, toolbar, and palettes and view the current image full screen,
click the view mode button in the toolbar and select Full Screen.

RN @RS A CT A Y VEE V(D 8

v £55 Thumbnail

"= Image Viewer

l = Full Screen

Compare before and after images 2 Images

To exit the full-screen display and return to the previous view, click the g button
or press the Esc key.

Capture NX-D Reference Manual 12
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Viewing Pictures

Side-by-Side Comparison

e e oberos e

To compare images, use the “multi” tool in the toolbar. Choose Compare Before and
After Images to compare before and after views of a single image, or 2 Images to
compare multiple images side-by-side. To exit the side-by-side comparison display,
select Single Preview.

*
—
ry

=P

[l compare Before and After Images

HC x Y VEE VO 8D

v 00 2images
55 4Images
{1l single Preview

Compare Before and After Images
Compare before and after views of the current image.

Capture NX-D  DSC_0001.NEF ( 10.1% )
File(F) EH(E)

m
B
B
B
E
]
B
[
E
o B
E
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m Updating the “Before” Image

To update the “before” image to reflect current image adjustments, click the
button in the toolbar. The “before” image can then be used as a reference for
subsequent changes to image adjustment settings.

m Restoring the “Before” Image

To restore the “before” image to its unadjusted state, click the [f button in the
toolbar. The “before” image will be restored to the state the image was in when
first opened in Capture NX-D (note that any changes made to JPEG and TIFF im-
ages in other applications since they were last opened in Capture NX-D will not
be reset).

13
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Viewing Pictures

I )

Side-by-Side Comparison

“2 Images”

Compare images side-by-side. When either image is zoomed or scrolled, the
other will be zoomed or scrolled to match.

Capture NX-D  DSC_0001.NEF ( 10.1% )

uti

“2 Images”

Computers with at least 4 GB of memory and 64-bit operating systems
offer a choice of two- and four-image displays. The “2 images” feature
on computers running 32-bit editions of Windows offers only a two-
image display.

[} compare Before and After Images
v [0 2 Images

EE 4Images
{11! gingle Preview

Capture NX-D Reference Manual

When you click the “multi” button and select 2 Images, the currentimage will be
displayed on the left. To select images for display, click the desired preview box
and then click a thumbnail. Only images in the same folder can be selected for
side-by-side comparison.

The selected preview is highlighted in white. Image adjustments apply only to
the selected preview, as do the histogram and navigation palette displays.

No adjustment Exposure compensation set to +1.0 EV

Comparing Images in the Preview Display
To open the images side-by-side in the preview display,
click the view mode button in the toolbar and select
Preview.
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Rating

Pictures can be assigned ratings of from [§ (no rating) to five stars. Ratings are assigned using the thumbnail rating icons or the Apply Ratings op-
tion in the Image menu.

Capture NX-D  DSC_0001.NEF
File(F) EGi(E) Ve

1 Select pictures.

To select multiple pictures, keep the Ctrl key
(or on Mac computers, the Fg/command key)
pressed while clicking each image in turn. To se-
lect two pictures and all images between them,
click the pictures while pressing Shift.

To assign the picture a three-star rating,
click the third star from the left. The first
three stars will be highlighted in yellow.

I “Apply Ratings”
Selected files can also be rated using the Apply Ratings option in the Image menu.

Capture NX-D Reference Manual 15
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Filters

Labelling

e I I

To make pictures easier to sort and locate, you can assign them labels of from “0”
(no label) through “9”, each with its own unique color.

E ‘Capture NX-D  DSC_0001.NEF

Capture NX-D Reference Manual

Ratings are assigned using the thumbnail label icons or the Apply Labels option
in the Image menu.

1 Select pictures.

4 To select multiple pictures, keep the Ctrl key
(or on Mac computers, the $g/command key)
pressed while clicking each image in turn. To se-
lect two pictures and all images between them,
click the pictures while pressing Shift.

2| Click a label (@; in the case of unlabelled images, the label “0” only appears
when the cursor is over the picture) and choose a label of from “0” (no label)
through “9” ().

(@ Click a label.

I “Apply Labels”
Selected files can also be rated using the Apply Labels option in the Image menu.

16
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Introduction

Filtering

e I I

To filter pictures using criteria such as ratings, labels, and photo information,
click the | button in the toolbar.

A dialog will be displayed where you can select |: Filter
filters. Only pictures that match at least one of the F”E"SCM
«[_]al ~
selected criteria will appear in the thumbnail list. E-D__}
.. Jorange (2)
[CTrellow (3)
[ JGreen (4)
~[Ceyan (5)
[Clelue (8)
[ JPurple (7)
[[IMagenta (g)
- Pink (3)
- INone (@)
=-[_]Rating
-1
Filters S
The options for the Model, Focal Length, Shutter Speed, "'i v
F Number, and ISO Sensitivity filters are restricted to values
found in the images in the current folder. . Conee

Capture NX-D Reference Manual

Quick Filters
Use the [ button in the toolbar to quickly filter pictures by rating and label.

Spe )y v EHE vie e
1 Click the [ button to display the filter bar.

EFEEEEEREE © Bk Xk kX k &

Filter bar
2| Choose a filter or filters from the options in the filter bar.
CT %
QO &k k k kK

If you select multiple ratings, all pictures with ratings in the selected range will be displayed.
For example, selecting ratings of three and five stars displays pictures with ratings of three,
four, and five stars.

Only pictures that match at least one of
the selected criteria will appear in the
thumbnail list.

Viewing All Pictures
To cancel filtering and display all pictures in the current folder, click the [ button in the toolbar.

rEkwEPSsge x Y(O)EE (Ve
17
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The Edit Palette

Most image adjustments are performed using Toollist | The Adjustment Palette
the edit palette, which consists of a tool list, an
adjustments palette, and tool buttons.

Use the adjustment palette to make detailed adjustments. Clicking a tool button
or anicon in the tool list displays settings for the selected item.

The Tool List

The tool list contains the items listed below.
All but Tone/Tone (Detail) apply exclusively to

v Original

w  Original Original
0.0ev

. v  Original F—'

RAW (NEF/NRW) images. o

Exposure Compensation Page 20 i L 1 fm 4 B8 v orignal aising)

. White Balance Page 21 BIE ~ originai ' Original

Picture Control Page 22 g— R I (m 4

BE Tone/Tone (Detail) Page 24 £+ Adjustments =i, xposure Compensation

. - <o + Original wposure Compensation

Settings for these tools can be selected from o e s
the pull-down menus. Selecting Original re- Paste Adjustments

stores settings to the values in effect when
the image was first opened in Capture NX-D. Save All Adjustments...
At other settings, a check (] appears in the
box to the right of the pull-down menu, and
changes can be hidden by removing the check Adjustment palette
from the box ().

Tools that have been modified using the adjustment palette are identified by the
label Manual in the tool list pull-down menus.

Capture NX-D Reference Manual 18
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e [ L 1

The Edit Palette

Tool Buttons

The following tools can be accessed using the

with RAW (NEF/NRW) images; for information,
see the section for each tool.

Noise Reduction Page 25

Camera and
Lens Corrections Page 26
LCH Page 27

E Straighten Page 29
Unsharp Mask  Page 30
Levels & Curves  Page 31

These tools are accessed by clicking the but-
tons and adjusting settings in the adjustment
palette. The buttons for tools that have been
modified from default values are highlighted
in yellow (e.g., @.

The Revert Button

Click the revert (“Revert to Original State”)
button to reset all tools and restore the im-
age to the state it was in when first opened in
Capture NX-D (note that any changes made
to JPEG and TIFF images in other applications
since they were last opened in Capture NX-D
will not be reset).

Capture NX-D Reference Manual

EH

v Original
~  Original

w Original

eduction
w Faster

Intensity

Lo

- Tool buttons

m v Original
E » Original

UIE w Original
e I 1 (m 41

Revert button

The Adjustment Manager Tool

Use the adjustment manager tool to copy ad- Adjustment manager

justments to other images or save current set- [EHlF
tings for later use (page 33). Edit

v Original

Uﬁ; w  Original
e I 1 (e 4

L} Adjustments

v Original

Fine-Tuning Multiple Images

Image adjustments apply simultane-
ously to all the images currently select-
ed in the thumbnail list.
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Introduction

Exposure Compensation (RAW Images)

e

Adjust overall exposure, making images lighter
or darker.

The pull-down menu in the tool list can be used to choose from values between
+1.0and -1.0 EV.

O (] +0.0ev

it
Edit
£
2 m +1.0ev
v ?"'E,.} gt *& &} *lizev
;”_f._ (, 7 — U [. +1/3ev
e T

g rr
1.' if’l;/ g.rh

+1.0EV

=

N

-1.0ev
ADL (Normaly

Manual

Register Adjustments. ..

Edit Registered Adjustments. ..

-1.0EV

Capture NX-D Reference Manual

For values between +5.0 and -5.0 EV,
incremented in steps of 0.01 EV, use the
Exposure Compensation control in the image
adjustment palette.

psure Compensation

Exposure Compensation

[
Active D-Lighting

The image adjustment palette also offers an Active D-Lighting menu that can
be used to bring out details in highlights and shadows.

Normal -

Active D-Lighting
Active D-Lighting is available only with RAW images taken using cameras that support Active
D-Lighting.
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Adjust white balance.

Incandescent

Direct Sunlight
Shade

Cloudy

Fluorescent (J000K)
Fluorescent (3700K)
Fluorescent (4200K)
Fluorescent (SO00K)
Flugrescent (6500K)
Flugrescent (T200K)

@ HK & g

Incandes-
cent

= =

Flash

FL-G1

FL-G2

TH-A1

TH-A2

Sodium-vapor Lamps

High Color Rendering Fluoresce. ..
High Color Rendering Fluoresce...
High Color Rendering Fluoresce...
High Color Rendering Fluoresce. ..
High Color Rendering Fluoresce...

Manual

Remister Adistments
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White balance can be fine-tuned using the
Color Temperature and Tint controls in the im-
age adjustment palette. Tint can be set to val-
ues between -12 and +12: choose lower val-
ues for less green and more magenta, higher
values for the opposite effect. The range of val-
ues available for Color Temperature vary with
the option selected for white balance.

m White Balance

Gray point sample tool

White balance can also be set by sampling the image: click the & (Gray Point
Sample Tool) button and click anywhere in the image to sample a single pixel,
or drag the cursor over the image to use the average color value for the selected
area. White balance for the entire image will be adjusted so that selected pixel
or area takes on a neutral gray color.

g I ! »‘(.ﬂ . ﬁ

White balance adjusted to givé blues a gray '
cast and the overall image a “warm” cast

= %

Elu’e-c;lrea samplecﬂjﬁ
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Picture Control (RAW Images)
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Adjust Picture Control settings.

The pull-down menu in the tool list offers a
choice of preset Picture Controls.

Capture NX-D Reference Manual

ne
n}

i I
4 pic

W i
Pictur
[SC
Y

Quick

Original

Original

Recorded Value
Standard
Neutral

Wivid
Monochrome
D2¥MODE1
D2¥MODE2
D2Z¥XMODE3
Flat

Partrait
Landscape

Manual

Register Adjustments. ..
Edit Registered Adjustments...

Color reproduction process

The controls in the image adjustment palette
can be used to choose a color reproduction
process, perform quick adjustments to the se-
lected control, or fine-tune individual Picture
Control parameters.

Selected Picture Control

Quick Adjust
m Color Reproduction Process

Choose one of the following options:

« Latest Picture Control: Colors are processed using the Picture Controls for the latest
Nikon cameras.

- Camera compatible: Colors are processed using the Picture Controls for the cam-
era that took the picture.

m Quick Adjust
Drag the slider left or right to mute or heighten the effect of the selected Picture
Control, or click Reset to reset the slider to zero. Quick adjust affects all Picture
Control settings simultaneously and cancels any changes made separately to
the individual parameters. It is not available with neutral, flat, or monochrome
Picture Controls.
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Picture Control (RAW Images)

m Picture Control Parameters

Fine-tune individual Picture Control parameters, including sharpening, clarity,
contrast, and saturation, or select Auto to let Capture NX-D adjust settings au-
tomatically (note that Auto produces results that may vary with exposure and
the position and size of the subject in the frame). What parameters are available
depends on whether a monochrome Picture Control is selected.

« Sharpening: Control the sharpness of outlines.
Choose higher values for more sharpening.

« Clarity: Adjust clarity (requires Latest Picture
Control or a picture taken with a camera that
supports the Clarity parameter).

« Contrast: Adjust contrast. Choose lower values
for less contrast, higher values for more con-
trast.

- Brightness: Adjust brightness without losing [
detail in highlights and shadows. g . ] Auto

- Saturation (non-monochrome only): Control the viv- |[—.
idness of colors. Choose lower values for less [ [ 0.00]
saturation, higher values for more saturation. contrast “ H A

« Hue (non-monochrome only): Adjust hue. : [ 0.00] 3

« Filter Effect (monochrome only): Simulate the effects S 01 Auto
of color filters on monochrome photographs. irifht"mm .

« Toning (monochrome only): Choose the tint used in | ————
monochrome photographs. Saturation _

- Toning Saturation (monochrome only): Choose the & mp
saturation of the tint used in monochrome [ie
pictures. Does not apply to black-and-white [

| 0.00]
images.

@ Picture Control

Latest Picture Control

—_—
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Note that Contrast and Brightness can not be adjusted if Camera compatible is
selected for pictures taken with Active D-Lighting or a Picture Control that uses
a custom curve.
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Tone/Tone (Detail)
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Adjust overall brightness and contrast, or make adjustments that affect only

highlights and shadows.

Tone

Clicking the icon shown in the illustration dis-
plays the following controls in the image ad-
justment palette:

« Brightness: Adjust overall brightness. Choose
from values between -100 and +100: the
higher the value, the brighter the result.

« Contrast: Adjust overall contrast. Choose from
values between -100 and +100: the higher
the value, the greater the contrast.

- Saturation: Control the vividness of colors.
Choose from values between -100 and +100:
the higher the value, the more vivid (saturat-
ed) the result.
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Original

Crriginal

Original

Brightness
-100

Contrast

-100

Saturation

-100

Tone (Detail)

Clicking the icon shown in the illustration dis-
plays the following controls in the image ad-
justment palette:

- Highlight Protection: Preserve details in high-
lights. Values range from 0 to 100: choose
higher values to reduce brightness in high-
lights.

« Shadow Protection: Preserve details in shadows.
Values range from 0 to 100: choose higher
values to increase brightness in shadows.

« D-Lighting HS: Brighten shadows in backlit or
poorly-lit pictures or reduce loss of detail in
highlights. Higher values reduce the contrast
between shadows and highlights.

Original

Crriginal
Original
Crriginal

i I I (m 4

® Tone (Detail

Highlight Protection

shadow Protection

0
b
&
D-Lighting HS
0
v
[

24



Introduction Viewing Pictures

Tool Buttons

e e

Use the tool buttons for access to tools not in the tool list.

Noise Reduction

Selecting this tool displays the following con-

trols in the image adjustment palette:

Noise Reduction: Enable or disable noise
reduction.

Method: Select Faster for faster processing,
Better Quality or Better Quality 2013 for
more accurate noise reduction. Selecting
Better Quality 2013 allows separate
Intensity and Sharpness adjustments for
Luminance and Color (RAW images only).
Intensity: Choose from values between 0 and
100. The higher the value, the smoother
the image and the less visible the artifacts
caused by image “noise”.

Sharpness: Choosing high values for Intensity
may smooth the image to the point that
details are lost; this can be countered by in-
creasing Sharpness.

Edge Noise Reduction (RAW images only): Make out-

Manual

Better Quality 2013
Luminance
Intensity
0
[

Color

Intensity

lines more distinct by reducing the occurrence of noise artifacts around edges.
« Astro Noise Reduction (RAW images only): Reduce the occurrence of randomly-spaced

bright pixels in long exposures.

Capture NX-D Reference Manual

Better Quality 2013

Better Quality 2013 excels in reducing color noise at short wavelengths and over evenly-colored

areas of the image.
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Tool Buttons

Camera and Lens Corrections

Selecting this tool displays the following con-
trols in the image adjustment palette:
« Color Moiré Reduction (RAW images only): To reduce
color moiré (an image artifact visible where Original
regular patterns overlap), select thisitem and [=fss®
choose an option from the menu. il
Image Dust Off (reqular- or large-size RAW images only): [RSEEEEEEE
Compare photos with reference datarecorded | ————-—-—-—————
using the camera to mitigate the effect of
dust on the low-pass filter. Click Change...
to choose the NDF file containing the desired
data. For more information on recording
reference data, see the camera manual.

Lateral Color Aberration: Reduce lateral color ab-

erration (colored fringes and halos) in RAW

images. At default settings, this option is not
applied to JPEG and TIFF images.

« Axial Color Aberration: Reduce blurred colors
caused by axial color aberration. Choose
from values between 0 and 100: the higher
the value, the greater the effect.

« Auto Distortion Control: This option uses the lens
information recorded with photographs to
reduce the barrel distortion associated with wide-angle lenses and the pin-
cushion distortion associated with telephoto lenses. Auto distortion control
can be turned on or off from the pull-down menu; if the photograph was taken
with an advanced camera with interchangeable lens fitted with a waterproof
lens, you will also be offered an On (underwater) option for reducing pin-cush-
ion distortion in photos taken underwater.

« Auto Red-Eye: Automatically detect and remove “red-eye”.

ﬂl;:ﬁ

IT Camera and Lens Corrections

piré Reduction

Aberration
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« Vignette Control: Adjust for variations in peripheral illumination that occur with
some lenses. Choose from values between -100 and +200: the higher the val-
ue, the greater the increase in brightness at the edges of the image.

« PF Flare Control: Reduce ring flare, circular flare, and other flare effects caused by
bright light sources in the frame.

- Fisheye: Process photos taken with AF DX Fisheye-Nikkor ED 10.5mm f/2.8G or
AF DX Fisheye-Nikkor ED 16mm f/2.8D lenses so that they appear to have been
taken with a wide-angle rectilinear lens.

m Image Dust Off
Follow the steps below to perform Image Dust Off.

1 Click Change.... If the current folder contains an Image Dust Off reference
file, a message will be displayed; proceed to Step 2. If no message is dis-
played, proceed to Step 3.

2| To perform Image Dust Off using the file in the current folder, select Yes.
Otherwise, select No and proceed to Step 3.

3| Select a reference file and click OK to perform Image Dust Off.

I Image Dust Off
Dust changes position from day to day; if possible, use reference data recorded in the last 24 hours.
If the camera offers image sensor cleaning, use only data recorded after the most recent cleaning, as
cleaning can change the position of the dust.
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Tool Buttons

LCH

The LCH color space models color using values
for lightness (a property similar but not identi-
cal to brightness or luminance), chroma (color
saturation), and hue. These parameters can
be accessed via the channel menu in the im-
age adjustment palette when the LCH tool is |[Crresrr s

LCH

v Original

selected. x:;r "I:ghtness
Hue

m Master Lightness

Adjust overall lightness without affecting I LcH

chroma or hue. Original

(D) Auto Contrast: Increase contrast by setting
the white and black points to exclude
a set proportion of the brightest and
darkest pixels in the image.

(2 Add Anchor Point: Click this button and
then click the image in the preview pal-
ette to add a point to the curve corre-
sponding to the lightness of the pixel
under the cursor.

(3 Reset Current Channel: Reset the master
lightness curve to linear.

(@) Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue
curves to linear.

(5) White-point output-level slider: Choose the
maximum output level (white point).
() Histogram: The histogram shows how the pixels in the image are distributed
with respect to lightness. The horizontal axis corresponds to lightness (in the

range 0-255), the vertical axis to the number of pixels.

1424304

Master Lightness
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(7 Luminosity curve: The slope and shape of the curve determines the lightness of
the image in the corresponding portion of the tone range.

Black-point output-level slider: Choose the minimum output level (black point).

(9) Black-point input slider: Choose the minimum (black point) input level.

(0 Gamma: Choose the midpoint (gamma value).

@1 White-point input slider: Choose the maximum (white point) input level.

m Color Lightness

Adjust the lightness of selected colors I0LcH

without affecting chroma or hue. This can v Original

be used, for example, to brighten the blue
of a dark skies.

(D Add Anchor Point: Click this button and
then click the image in the preview pal-
ette to add a point to the curve corre-
sponding to the value for the pixel un-
der the cursor.

(@) Reset Current Channel: Reset the color light-
ness curve to linear.

(3) Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue
curves to linear.

(@) Color lightness curve: Moving a point on
the curve upwards makes colors in
the affected portion of the color range
brighter, while moving it downward makes the affected colors darker.

(&) Width slider: Adjust the width of the curve that passes through the selected
point, increasing or decreasing the range of colors affected by the change.
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m Chroma
Increase or decrease color saturation over I LcH
the entire image or a portion of the color p—

range, making colors more or less vivid.

(D Add Anchor Point: Click this button and
then click the image in the preview
palette to add a point to the curve cor-
responding to the chroma of the pixel
under the cursor. @

(@ Reset Current Channel: Reset the chroma |
curve to linear. @

() Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue
curves to linear.

(@) Chroma curve: Moving a point on the
curve upwards makes colors in the af-
fected portion of the color range more (6)-am =
vivid, while moving it downward makes
the affected colors less vivid (grayer).

(5) Output slider: Increase or decrease the saturation of all colors in the image.

(8) Width slider: Adjust the width of the curve that passes through the selected
point, increasing or decreasing the range of colors affected by the change.

(@ Exclude Gray: Increasing chroma may make neutral colors (grays) seem over-
saturated. Select this option to increase chroma without affecting grays.

Capture NX-D Reference Manual

Tool Buttons
m Hue
Map selected colors in the original (input) ] LcH
image to a specific range of colors in the fi- p——
nal (output) image. One application might g

be to deepen the colors in a pale blue sky.

(1) Add Anchor Point: Click this button and
then click the image in the preview pal-
ette to add a point to the curve corre-
sponding to the hue of the pixel under
the cursor.

(@) Reset Current Channel: Reset the hue curve
to linear.

(3) Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue
curves to linear.

@) Scale: Click to change the vertical scale
from 60 ° through 120 ° to 180 ° and
back again (in this case the degrees re-
fer to a 360 ° color wheel). Increasing the scale increases the range of hues
visible in the display, while decreasing the scale increases precision.

() Hue curve: Select a point on the curve that corresponds to the desired input
color and drag it up or down until it intersects with the desired output color.

() Output slider: Modify the hue of all colors in the image.

(7) Width slider: Adjust the width of the curve that passes through the selected
point, increasing or decreasing the range of colors affected by the change.
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Straighten

Straighten pictures by up to 10 °. Choose
lower values to rotate the picture to the left,
higher values to rotate it to the right.

[ Include areas

ithout image data

Straighten tool
To straighten pictures manually, click the straighten tool in the image adjust-
ment palette and drag the cursor parallel to a line in the preview (this option can
not be used with thumbnails; page 10). The image will be rotated by up to £10°
to make the reference line horizontal or vertical, and the degree of rotation will
be displayed in the text box in the image adjustment window. Unless Include
areas without image data is selected, the image will automatically be cropped
to remove any empty corners.

Image rotated to make reference line horizontal
and cropped to remove empty corners

Capture NX-D Reference Manual

m Include areas without image data
If this option is selected, images will not change size when straightened, and any
empty areas added to keep images the same size will be filled in black.

Drag cursor parallel to reference line

Image rotated to make reference line horizontal
and with empty corners filled in black to main-
tain original size
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Unsharp Mask (8) Radius: The greater the radius, the wider the edges in the sharpened image
will appear.

(7 Threshold: The limit at which sharpening will be applied. If the threshold is
zero, sharpening will apply to all pixels in the image. Increasing the threshold
increases the amount of contrast that must be present between pixels before
the mask will be applied, with the result that only more distinctly contrasting
edges will be affected.

Increase sharpness by making edges more dis-
tinct. The contrast of edges is increased while
other areas are left untouched.

(D Delete: Delete the currently-selected
mask from the unsharp mask list.

(2 Move Up/Move Down: Move the currently-
selected mask up or down in the un-
sharp mask list. RGB 30% 5% 20

(3) Unsharp mask list: A list of unsharp masks,
identified by color channel, intensity,
halo width, and threshold (e.g., “Red,
50%, 10%, 0”). Masks apply in the order
listed; to change the order, use the up/
down buttons.

(@ Color: Choose the color channel to which
the unsharp mask applies.

(5 Intensity: The amount edge contrast will
be increased.
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Tool Buttons

Levels & Curves

Adjust contrast, tone (brightness), and color

balance. Adjustments can be made over the

entire image or to specific portions of the tone range (for example, the gamut of

a specific printer, monitor, or other output device), allowing enhancements to be

made without sacrificing detail.

(D Channel: The current color channel.

(@) Auto Contrast: Increase contrast by set-
ting the white and black points to ex-
clude a set proportion of the brightest
and darkest pixels in the image, creat-
ing a curve that makes optimal use of
the output tone range while preserv-
ing details in shadows and highlights.

(3) Set Black Point: Click this button and then
click the image in the preview palette
to set the black point for the red, green,
and blue channels to the value for the
pixel under the cursor.

(@) Set Neutral Point: Click this button and
then click the image in the preview
palette to set the midpoint for the red,
green, and blue channels to the value
for the pixel under the cursor.

(5) Set White Point: Click this button and then click the image in the preview pal-
ette to set the white point for the red, green, and blue channels to the value
for the pixel under the cursor.

(8) Add Anchor Point: Click this button and then click the image in the preview area
to add a point to the curve corresponding to the value of the pixel under the
cursor.

(@) Reset Current Channel: Reset the curve for the current channel to linear.
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Reset All Channel: Reset all curves to linear.

(9) White-point output-level slider: Choose the maximum output level (white point).
Dragging the slider down lowers the brightness of the brightest pixels.

10 Histogram: The histogram shows how the pixels in the image are distributed
with respect to brightness. The horizontal axis corresponds to brightness (in
the range 0-255), the vertical axis to the number of pixels.

@D Tone curve: The slope and shape of the curve determines the brightness of the
image in the corresponding portion of the tone range.

12 Black-point output-level slider: Choose the minimum output level (black point).
Dragging the slider up increases the brightness of the darkest pixels.

(3 Black-point input slider: Any pixels in the portion of the tone range to the left of
the black point are output at the minimum output level. Dragging the slider
to the right steepens the curve and enhances contrast but may cause loss of
details in shadows.

(4 Gamma: Dragging the slider to the left increases the brightness of mid-tones,
while dragging it to the right makes mid-tones darker.

(5 White-point input slider: Any pixels in the portion of the tone range to the right
of the white point are output at the maximum output level. Dragging the
slider to the left steepens the curve and enhances contrast but may cause
loss of details in highlights.

Sampling the Current Channel
By default, the black point, white point, add anchor point, and auto contrast controls respectively set
the black point, anchor points, white point, and contrast for all channels. To apply these controls only
to the current channel, press Ctrl (or on Mac computers, the option key) while clicking the control.
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Image adjustments can be copied and applied to other pictures, speeding the
process of enhancing pictures taken under similar conditions.

Adding Adjustments to the Tool List

Current settings can be added to the menus in the tool list.

1 Select a tool from the tool list and adjust Exposure Compensation
settings in the adjustment palette. Here [EErms
we have set exposure compensation
(page 20) to +1.50.

2| Select Register Adjustments from the

pull-down menu in the tool list. :
ﬂ' + Manual
~ Manual

-1.0ev
ADL (Mormaly

ister Adj ents...
stered Adjustments...

+ Unchanged
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3| Enter a name for the new setting and click
OK. In this example, we have named the
setting +1.5.

The new setting is added to the pull-down
menu and can now be applied to other
pictures.

Selecting Edit Registered Adjustments from
the pull-down menu displays a dialog where you
can rename or delete previously-saved settings.

Register Adjustments
MName
Delete
Rename
cancl

 Manual

v +1.5

Manual

Register Adjustments. ..
Edit Registered Adjustments...
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Copying Adjustments

The Adjustment Manager Tool

The adjustment manager can be used to apply multiple adjustments simultane-
ously.
« Copy Updated Adjustments: Copy all adjustments

that have been changed since the current Original
folder was selected.
« Copy All Adjustments: Copy all adjustments. Original
- Paste Adjustments: Apply adjustments copied Original

U“E + Driginal
W D e 4D

ﬂ Adjustments

using Copy Updated Adjustments or Copy
All Adjustments to the currently-selected
image or images.

- Save Updated Adjustments: Save all adjustments
that have been changed since the current
folder was selected.

« Save All Adjustments: Save all adjustments.

« Load Adjustments: Select an adjustments file
saved using Save Updated Adjustments or
Save All Adjustments and apply it to the cur-
rently-selected image or images.

« Register Updated Adjustments: Any adjustments
that have been changed since the current
folder was selected are saved and added as
an option to the adjustment manager pull-
down menu.

« Register All Adjustments: All current adjustments are saved and added as an op-
tion to the adjustment manager pull-down menu.

- Edit Registered Adjustments: Reorder, rename, or delete adjustments previously
added to the adjustment manager pull-down menu.

+ Original
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m Copying Adjustments to Other Pictures
Follow the steps below to copy adjustments and apply them to other images.

1 Adjust settings in the edit palette. Here we have set exposure compensation
(page 20) to —'2 EV and selected the Vivid Picture Control (page 22).

» Manual

2| Click the adjustment manager [&] icon
and select Copy Updated Adjustments or
Copy All Adjustments from the options in
the adjustment palette. Here we have se-
lected Copy All Adjustments.

{:} Adjustments

w Manual

Copy Updated Adjustments

ustments

Paste Adjustments

3| Select images. In this example, the selected image has already been ad-
justedusingtheexposurecompensation(page20)andwhitebalance(page21)
tools.

v Manual

v Original

» Original
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Copying Adjustments

4| Click the adjustment manager [5Jicon and [Eegms
select Paste Adjustments from the op-
tions in the adjustment palette.

m Copying Adjustments to Other Computers

The Save Updated Adjustments and Save All
Adjustments options save image adjustments
to a file which can be copied to other computers.

+ Manual

Copy Updated Adjustments

T | stments

The adjustments can then be applied to selected -
pictures on the other computers using Load
Adjustments.
The adjustments copied in Step 2 are applied to the images selected in ) =L

Step 3. Because we selected Copy All Adjustments in Step 2, exposure com-

m Adding Adjustments to the Adjustment Manager
pensation changes to -2 EV while white balance reverts to Original.

Use the Register Updated Adjustments and Register All Adjustments options
to add adjustments to the adjustment manager pull-down menu.

Register Adjustments
+ Manual
MName
[exp-0.5 pevivd_| Move Lp
Move Down
2EE [ exp-0.5_pcVivid m
Rename Manual
Register Updated Adjustments. ..
. . . Register All Adjustments...
H.ad we selected Copy Updateg Adjustments in Step 2, the exposure compensgtmn and i Ragistered Adustmanks...
Picture Control for the selected image would have been set to the values selected in Step 1,
while white balance would have remained at the value selected in Step 3.
conce

When adjustments are copied from RAW (NEF/NRW) to JPEG or TIFF images, exposure compensa-
tion, Picture Controls, and other settings that are available only with RAW images will not be applied.
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To save RAW (NEF/NRW) images in JPEG or TIFF format, click the i button in the
toolbar.

®°

A dialog will be displayed where you can choose a file format and adjust such
settings as compression and image size.

. T .
@ [Sa\re as type: TIFF (*tif) v] Cancel
@[File format: | TIFF 8bit ] ]
Image quality

Qualiby Good Balance ]

Cuality
WJ [D Use LZW oompressicn] @

Qutput settings
@ [ Resclution 300 | dpi @
Image size
[ spedify size
@ Long edge Shart edge Uit
4256 | % 2332 pixel

(1) Save as type: Choose JPEG or TIFF.

(@ File format (TIFF only): Choose the bit depth for TIFF images (8 or 16 bits per chan-
nel).

(3) Quality (JPEG only): Use the slider or pull-down menu to choose a value between
0 and 100. The higher the value, the lower the compression ratio and the
higher the image quality; the lower the value, the higher the compression
ratio and the smaller the file size.

() Use LZW compression(TIFF only): Compress TIFF files using “lossless” LZW compres-
sion.

[% LZW compression may sometimes increase file size when applied to 16-bit images.

(5) Resolution: Select this option to choose the output resolution.
(8) Embed ICC profile: Select this option to embed the current color profile in the
image.
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() Specify size: Select this option to resize pictures saved in the new format. The
new size can be entered in pixels, centimeters, or inches. When you enter a
value for either Long edge or Short edge, the remaining value will automati-
cally be adjusted to maintain the original aspect ratio.
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Cropping Pictures

To crop unwanted areas from images, click the [ button in the toolbar. 1 Choose an aspect ratio in the crop palette (to select a free crop with no fixed
aspect ratio, choose Free Crop).

Wl Free Crop
Custom

11

16:9

4:3

- 32

el Lol b [ =0 wr
1.41:1 (A series)
1.41:1 (B series)
e

65

54

Photo Ratio

(1) Aspect Ratio |The crop aspect ratio. Choose Free Crop to select a crop with no fixed aspect ratio.

' — ‘ The aspect ratio can be changed after you have resized and positioned the crop.
@ Custom For custom aspect ratios not listed in the aspect ratio menu, select Custom and enter the

Aspect Ratio |desired aspect ratio.

2| Drag the cursor over the image to select the crop. The area outside the crop
is shown in gray.

(3 RotateCrop |Rotate the crop 90°.

(@) Show Grid Display an evenly-spaced 3 x 3 grid inside the crop.

(5 Reset Crop Reset the current crop.

(& Cancel Cancel the current crop.

(@) ApplyRatio |Apply the current crop.

Capture NX-D Reference Manual 36



Introduction Viewing Pictures “ Image Adjustment Other Features ma

Cropping Pictures

3| Drag the corners of the crop to resize it without changing the aspect ratio.

To reset the crop, click Reset Crop.

4| Double-click inside the crop or click the Apply Ratio button in the toolbar to
crop the image.
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4 Crop
Crops are not applied to the original image data and can be changed at any time by clicking the
button in the toolbar. This also applies in the case of images cropped using ViewNX 2 or ViewNX-i.

Crops are applied when images are converted to JPEG or TIFF (page 35). When NEF/NRW (RAW) im-
ages cropped in Capture NX 2 are opened in Capture NX-D, the crop is treated as the entire image;
to select a crop that extends outside these bounds, click the revert button (page 19) to restore the
original image and then select the desired crop.
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Other Features

The File > Run Batch Process option can be used to perform the same image
adjustments on all pictures in a selected folder and then export the processed
images in a selected file format. Batch processing options are shown below.

Batch Process

Source folder

CI C:\Users\user'\Pictures Browse. ..
| [Jindude subfolders

N

Adjustments
(2 Apply current adjustments

@ () Adjustments to apply:

(@) Apply adjustments already in files

[File format: | JpEG W ] 3)
Image quality 7

| Quality Good Balance v ]
@ Quality
H o o) ©

COutput settings
6/ [[]Resolution 300 | dpi | Embed ICC profile | @
Image size
~ [ specify size
<8 Long edge Short edge Unit
il b3 pixel
Destination
| Use source folder [Juse source fie name
(9 Savein: C:\Users\user\Pictures Browse...
File name: Edit...
Start Cancel

(D Source folder: Click Browse to choose a source folder. To include all images in
sub-folders under the selected folder, select Include subfolders.

(@) Adjustments: Select Apply current adjustments to process the images using
the adjustments for the current image. To apply adjustments previously
saved from the adjustment manager, choose Adjustments to apply and click
Browse to choose an adjustments file. To export the images in the selected
folder in another format without changing the settings currently selected for
each image, choose Apply adjustments already in files.

(3 File format: Select the format in which the processed files will be saved. Choose
from JPEG, TIFF 8bit, and TIFF 16bit.
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(@) Quality (JPEG only): Use the slider or pull-down menu to choose a value between
0 and 100. The higher the value, the lower the compression ratio and the
higher the image quality; the lower the value, the higher the compression
ratio and the smaller the file size.

(5) Use LZW compression(TIFF only): Compress TIFF files using “lossless” LZW compres-
sion.

[% LZW compression may sometimes increase file size when applied to 16-bit images.

() Resolution: Select this option to choose the output resolution.

(7) Embed ICC profile: Select this option to embed the current color profile in each
image.

(8) Specify size: Select this option to resize pictures saved in the new format. The
new size can be entered in pixels, centimeters, or inches. When you enter a
value for either Long edge or Short edge, the remaining value will automati-
cally be adjusted to maintain the original aspect ratio.

(9 Destination: Select Use source folder to save the processed files to the current
folder. To choose a different folder, remove the check from this option and
click Browse. To save the processed files under the same names as the origi-
nals, select Use source file name (if a file with the same name and extension
already exists in the current folder, the processed file will be renamed by add-
ing a number to the file name); to choose different names, remove the check
from this option and click Edit.
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Other Features

Batch Processing

Clicking Start starts processing and displays a progress dialog. Progress can be
viewed in the Queued and Finished tabs.

Batch P 5 3 15 Batch Pr

J Queued

DSC_0001.MEF
DSC_0002JPG

D3SC_0001.NEF
D3C_0002.4PG

[% Color Efex Pro
If the source contains files modified using the Color Efex Pro plug-in for Capture NX 2 or Capture NX, a
message will be displayed and the images will not be processed.

File Conversion

DSC_0003.JPG
DSC_0004.MEF
D3C_0005.MNEF
DSC_0006.MNEF
DSC_0007.TIF

DSC_0003.JPG

D3C_0004.MEF
D3C_0005.MEF
D3C_0006.MEF
DSC_0007.TIF

DSC_0001_000(
DSC_0001_000¢
DSC_0001_000¢

Queued Finished
(D Source: A list of the files that are awaiting processing or have been processed.
(2) Automatically Show/Hide: Removing the check from this option hides the prog-
ress dialog. The progress dialog can be displayed by clicking the [E button in
the toolbar.

HanNREPSHEC XYY
(3 Delete: Click to remove the file selected in the Queued tab from the queue, or
to delete the log for the file selected in the Finished tab.
(4) View folder: Open the destination folder in the operating system file browser.
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If multiple files are selected when the B button in Convert Selected Files (Run as Batch Process)
the toolbar is used to export files in another format | . Fle ot | G v
s
(page 35), the files will be exported as a batch process. Qualty Good Belance v
K . . . Quality
Adjust settings as described for items (3) through (® Co T —
Output settings
on @gei?’S DRE“\W; 300 [#] Embed ICC profile
Image size
[] specify size
4255 pixel
Destination
Use source folder ["Use source fie name
Savein: C:\Jsersluser\Pictures Browse...
File name: | DSC_0001_00001.jpa Edit...
Cence
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Printing Pictures

To print pictures on a printer connected to the computer, select the pictures and
choose Print in the File menu. The “Print” dialog will be displayed.

Print 1images selected

sssss
Printer Type: Inket

Print Priority: Quaiity

[Rotate to fit

[cropimagesto it

Background Color: Vihite

Border width: 0 v pt

Copies of each image: 1w

[print Information Settings...

< IR [] Feoupit.. e

Adjust settings as described on the following page and click Print to print the
picture as shown in the preview.

Notes on Printing

To print to a JPEG file, click File Output.

The most recently-used settings are recalled when the print dialog is next displayed.

Capture NX-D Reference Manual

The “Print” Dialog

« Full Page: Print one picture per page.
- Index Print: Print multiple images per page (page 42).

PrintType . ctandard Photo Sizes: Print pictures at a standard photo size. Capture NX-D automatically
chooses the number of pictures printed on each page.
Printer  Click Settings to choose the printer and paper size and adjust other printer settings.
T PrinterType Choose Inkjet when printing on an inkjet printer.
'E’ When printing NEF/NRW (RAW) pictures, choose Speed to use the preview data embed-
& | PrintPriority ded in the image for faster printing, or Quality to use the original image data for higher
S quality output.
Copies Choose the number of copies of each page printed.
Rotate to fit Rotate pictures to print them at the largest possible size.
Cropimages Pictures are enlarged to fill the print area. Portions that do not fit in the print area are
to fit cropped out.
> Baclc(glr:rnd Choose the background color. Choose White to print with no background.
(=]
m
& Border width Choose the width of the borders printed around the image (the color of the borders varies
2 with the background color). Choose 0 to print without borders.
Copl-es of Choose the number of copies of each photo printed.
each image
Print ! . . ' .
Information Print the file name, date of recording, or photo information under each picture (page 41).
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Printing Image Information

Other Features

To choose the information printed under each picture, select Print Information
in the“Print”dialog (page 40), click Settings, and adjust the settings described on

the following page.

Print 1images selected

Prink Type:

Printer Setup
Printer

Paper: At

Printer Type:
Print Prority:
Copies

Page Layout

Cotate o fit
Dlerop

FullPage v

Resize Image

Inket v

Quaiity v

Advanced Print Information Settings

Date/Time Shat | Metadata
[]pate Shat
Time Shot

Position:
Inside Top Right
®) Inside Bottom Right

Outside Bottom Right

Font Settings:

Microsoft Sans Serif

Sample

Header /Footer

Regular Auto

7/15/2015 13:21:12.00

[ Print Information

Print information is not rotated when Rotate to fit is selected in the “Print” dialog. Metadata that

does not fit in the print area will be omitted.
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Advanced Print Information Settings

?, Date Shot  Print the date of recording in the position selected for Position.
% Time Shot  Print the time of recording together with the date.
3
2 . Choose the font, style, font point size, and color used to print the date/time stamp. The
£ | Font Settings . . p "
= results can be previewed in the “Sample”area.
Choose the file and photo information printed with each picture. The font, style, and font
Metadata o : P o : . p "
point size can be selected in the “Font Settings”area and previewed in the “Sample” area.
Header Enter the text and choose the alignment for the header that will be printed at the top of
each page.
Choose whether to print the page number and the total number of pages and select the
= Page . : i )
3 position and alignment. The page number can be positioned at the page Top (in the
2 Number .
g header) or Bottom (in the footer).
E, Footer Enter the text and choose the alignment for the footer that will be printed at the bottom
= of each page.
EMtSEing Choose a font, style, and font point size for the header, footer, and page number. The re-

sults can be previewed in the “Sample” area.
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Index Prints

Other Features

To print multiple images per page, select Index Print for “Print Type”in the “Print”
dialog (page 40) and choose the number of pictures printed per page.

Print 8images selected

el =

Standard

Choose the number of pictures per page from
a list box. The size of the pictures is automati-
cally adjusted according to the option selected.
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A2 x4 layout

Image Size

Pictures are printed at the size entered for
“Width” and “Height” (the minimum size is
20.0 mm x 20.0 mm and the maximum the
same as the page size). The number of pictures
per page is automatically adjusted according
to the size selected.

Column and Row

Choose the number of columns and rows
printed per page (the minimum is 1 and the
maximum 10). The size of the pictures is au-
tomatically adjusted according to the options
selected.

Pictures printed at 50 mm x 50 mm

A 3 x 3layout
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Preferences

Other Features

To modify the default behavior of Capture NX-D, select Preferences... in the Edit
menu (or on Mac computers, the Capture NX-D menu).
Preferences

Cache Settinas |

2 GB (Default) V][ Clear Cache ‘(2

@4

Maximum cache capacity:

Delete

|1 ] spedify cache folder
@ Existing cache handling: Delete cache folder

T l Browse...

Color Management Setinas

Default RGE color space: Mikon SRGB 4.0.0,3002 ]
@ [[] Use this instead of embedded profile

| [ Use this profile when printing
5 Printer profile: No profile
0 l Intent: Perceptual

Open With Application

[ Name Location il

6

@)

Place Open With file in:

S,

Ci\Users'userPictures Browse...

(S
Levels & Curves
[ Auto-contrast dip: Black: 0.50 | 95 White: 0.50 %]
(e

Dropper sample size: Point sample v J
/e

Il Other Settings

0 Iﬂ Display preview image faster '

il [Color reproduction process: | Camera compatible V(1 1

@ﬁhvjmumﬂ'\umhnaﬂwidiﬁ: 320 v ]
e

(1) Maximum cache capacity: Select a cache size.

(@) Clear Cache: Clear the cache.

(3) Specify cache folder: Select this option to choose a cache folder using the
Browse... button. Use the Existing cache handling menu to choose what to
do with the existing cache.

(4) Default RGB color space: Choose the default RGB color space for image display.

(5) Use this profile when printing: Select this option to choose a color profile for print-
ing from the Printer profile menu. Choose the Intent from Perceptual and
Relative colorimetric.

(8) Open With Application: Edit the list of applications that can be accessed via the
Open With option in the File menu (page 44).

=\

o | [ ]
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(7 Place Open With file in: Before being opened in other applications, images are
converted to 16-bit TIFF. Use this option to choose where the converted files
are stored.

Auto-contrast clip: The levels and curves auto contrast option (page 31) increases
contrast by setting the white and black points to exclude a set proportion of
the brightest and darkest pixels in the image. Choose the percentage of pix-
els excluded by the new Black and White points.

(9) Droppersamplesize: Select the size of the area sampled by the gray point (page 21)
and levels and curves (page 31) sampling controls. Choose from Point sample
(a single pixel), 3x3 Average (the average of an area 3 pixels square) and 5x5
Average (the average of an area 5 pixels square).

(0 Display preview image faster: If this option is selected, Capture NX-D will generate
preview data as modifications are made for faster preview display.

@D Color reproduction process: Choose a color reproduction process (page 22).

(2 Maximum thumbnail width: Choose the maximum thumbnail width, in pixels
(page 10).
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Menu Guide

Menu Guide

The Capture NX-D Menu (Mac Only)

« About Capture NX-D: Display the product version

About Capture NX-D
- Preferences: Open the Capture NX-D preferences

number.

dialog (page 43).
Quit Capture NX-D: Quit Capture NX-D.

The File Menu

New Folder: Create a new sub-folder in the
current folder.

Rename Folder: Rename the current folder.
Launch Camera Control Pro 2: Launch

Camera Control Pro 2.

Synchronize Edits: Select this option to ap-
ply current settings to any images subse-
quently added to the current folder.

Open with ViewNX-i: View the current image
or images in ViewNX-i. The images are dis-
played in their current state including any
changes made using Capture NX-D and, in
the case of NEF/NRW (RAW) images, with-
out conversion to TIFF. This option is only
available if ViewNX-i is installed.

Open With: Open the current image in another application. Use the Open With

Preferences...

ces

S’:r"\r'

Hide Others
Show All

Quit Capture NX-D

3,

Hide Capture NX-D  #H
N ¥H

#0Q

ric) I

Mew Folder
Rename Folder

Cirl+M

Launch Camera Cantrol Pro 2
Synchronize Edits

Open with ViewMX-i
QOpen With

Ctri+0

Open in Explorer

Launch Picture Control Utility 2

Rename... F2

Convert Files... Cirl+E

Run Batch Process... Ctrl+B
Page Setup... Ctrl+Shift+P
Print... Cirl+P

Exit Cirl+Q

Application option to add applications to the menu (page 43).

Open in Explorer (Windows)/Show in Finder (Mac): Open the current folder in the operat-

ing system file browser.
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« Launch Picture Control Utility 2: Launch Picture Control Utility 2.

+ Rename: Rename the current image.

« Convert Files: Convert the currently-selected image or images to JPEG or TIFF for-

mat (page 35).

« Run Batch Process: Perform batch processing (page 38).

- Page Setup: Adjust printer settings.
« Print: Print images (page 40).
« Exit (Windows only): Exit Capture NX-D.

The Edit Menu

+ Undo: Undo the most recent operation.

« Redo: Redo an operation after performing Undo.

« Cut/Copy/Paste: Cut, copy, or paste the current selec-
tion.

+ Delete: Delete the current selection.

« Select All: Select all images in the current folder.

« Select Inverse: Select all images in the current folder
that are not currently selected and deselect any im-
ages that are currently selected.

« Deselect: Deselect all images.

« Select File: Select all files in the current folder that

match the criteria chosen in the Select File submenu.

coe) [
Undo Cirl+Z
Redo Cirl+Y
Cut Crl+X
Copy Ctrl+C
Paste Crl+v
Delete Delete
SelectAll Ciri+A
SelectInverse  Cirl+Shift+A
Deselect
Select File 3
Preferences...  Cirl+K

« Preferences (Windows only): Open the Capture NX-D preferences dialog (page 43).
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Menu Guide
The View Menu The Image Menu
- Go: Navigate the folder hierarchy. viewty) [N | - NextImage/PreviousImage: View the next or previ-  image() [
« Thumbnail/lmage Viewer/Preview/Full Screen: = Go ' ous image in the current folder. Nextimage Right Arrow
. . N . Previ I LeftArr
Choose how images are displayed ~ Thumbnail il « Rotate: Rotate the current image 90 or 180 de- SO TR -
v Image Viewer Alt+9 Rotate 90°CW Crl+R
(page 10). Preview P grees. Rotate 90°CCW Crl+Shift+R
« Compare Before and After Images/2 Images/ Full Screen F Rotate 180°
4Images: Compare images (page 13). The ~ Compare Before andAfter Images Show Grid Ctri+G
4 Images option is available only on a ~_ 2!mages Show Focus Point  Ctri+Shift+F
. . . Thumbnail Size ’ Show Lost Highlights  Shift+H
computer with a 64-bit operating sys- Sort Thumbnais by g Show Lost Shadowe  Shifes
tem and at least 4 GB of memory. o P P N
+ Thumbnail Size: Choose the thumbnail size == = s Apply Ratings »
(page 10). Zoom Out Ctri+
« Sort Thumbnails by: Sort thumbnails. Fitto Screen Alt+Ctri+0 - Show Grid: Display a grid over the preview.
- Filter: Filter images according to selected =~ Viewat2s%
. View at 50% Clrl+Alt+5
criteria (page 17). T ClrieAlte1
+ Zoom In/Zoom Qut/Fit to Screen/View at 25%/ ~  view at200%
View at 50%/View at 100%/View at 200%/View __“ieWat400%

at400%: Zoom the preview in or out.

« Show Focus Point: Show the focus point in the pre-
view display.
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Menu Guide

- Show Lost Highlights: View areas of the image |
with the maximum value for brightness and in
which details may have been lost to overexpo-
sure (“washed out”). A different color is used to
show the lost highlights for each of the RGB, red,
green, and blue channels.

Show Lost Shadows: View areas of the image with
the minimum value for brightness and in which
details may have been lost to underexposure. A
different color is used to show the lost shadows
for each of the RGB, red, green, and blue chan-
nels. L i
« Apply: Label (page 16) or rate (page 15) selected images.
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The Adjust Menu
« Revert to Original State: Reset all image ad- |adusta) [

justments and restore the picture to its = RevertioOriginal State
original state Revertto Last Saved State

« Revert to Last Saved State: Initialize the set-

Copy Updated Adjustments

Copy All Adjustments Ctrl+Shift+C
tings file (page 3), cancelling all changes Paste Adjustments Clri+Shift+V
made in Capture NX-D. Save Updated Adjustments...

- Copy Updated Adjustments: Copy only those ad- =~ SaveAllAdiustments... Clri=Shift=S

Load Adjustments. .. Clrl+3Shift+0

justments that have been changed since the
current folder was last opened.

« Copy All Adjustments: Copy all adjustments.

« Paste Adjustments: Apply to the current image adjustments copied using Copy
Updated Adjustments or Copy All Adjustments.

- Save Updated Adjustments: Create a file containing only those adjustments that
have been changed since the current folder was last opened.

« Save All Adjustments: Save all adjustments to a file.

« Load Adjustments: Load adjustments from a file created with Save Updated Ad-
justments or Save All Adjustments and apply them to the current image.

In the case of JPEG and TIFF images modified in Capture NX 2 or ViewNX 2, Revert to Original State
reverts the image to its last saved state.
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Menu Guide
The Tool Menu The Window Menu
- Fit: Double-click the display to alternately zoom the [Tooitr) || NS | - Histogram/Edit/Metadata/Bird’s Eye/Folders: View or hide Windowtw) [
preview to fit the palette and zoom to a 100% view. Fit E the selected palette. v Histogram
inati Edit Cirl+T
- Combination Tool: As above, except that the preview ° g::::?:;m el : « Show Tool Bar: View or hide the toolbar. : Me'tadata cirle]
can be scrolled by dragging the cursor. Hand Tool H « Show Status Bar: View or hide the status bar. v Birds Eye
« Zoom Tool: Click to zoom in. To zoom out, click while Gray Point Sample Tool W « Show Pallets: View or hide all palettes. v ALIEE
pressing the Alt key (or on Mac computers, the op- ~ CfopTeal = - Customize Toolbar: Customize the toolbar (page 8). v Show Tool Ear
tion key) Straighten Tool R v Show Status Bar
. v Show Pallets Tab
« Hand Tool: Drag to scroll the preview. Customize Toolbar v
« Gray Point Sample Tool: Set white balance by sampling the preview (page 21).
« Crop Tool: Crop the preview (page 36). The Help Menu
- Straighten Tool: Straighten the image in the preview palette (page 29).
- Capture NX-D Help: View online help. reio) [
« Check for Updates: Check for updates to Capture NX-D. Capture NX-DHelp ~ F1
« About Capture NX-D (Windows only): Display the product ver- ~_ ©heckforUpdates
sion number. About Capture NX-D
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